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Introduction

Welcome to Adobe Illustrator CS4 On Demand, a visual quick
reference book that shows you how to work efficiently with
Illustrator.  This book provides complete coverage of basic to
advanced Illustrator skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
If you’re searching for what’s new in Illustrator CS4, just look
for the icon: New!. The new icon appears in the table of con-
tents and throughout this book so you can quickly and easily
identify a new or improved feature in Illustrator. A complete
description of each new feature appears in the New Features
guide in the back of this book.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
Ctrl+P (Win) or A+P (Mac), as a quicker alternative to using
the mouse. A complete list of keyboard shortcuts is available
on the Web at www.perspection.com.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Workshops

Adobe Certified Expert

Get More on the Web
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ple files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
throughout the book. The example
files that you need for project
tasks along with a complete file
list are available on the Web at
www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.
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The Workshop
walks you
through in-depth
projects to help
you put Illustrator 
to work.

Introduction xix

Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshop. You start each
project with a sample file, work
through the steps, and then com-
pare your results with a project
results file at the end. The Work-
shop projects and associated files
are available on the Web at
www.perspection.com.

Adobe Certified Expert
This book prepares you fully for
the Adobe Certified Expert (ACE)
exam for Adobe Illustrator CS4.
Each Adobe Certified Expert certifi-
cation level has a set of objec-
tives, which are organized into
broader skill sets. To prepare for
the certification exam, you should
review and perform each task
identified with a Adobe Certified
Expert objective to confirm that
you can meet the requirements for
the exam. The Adobe Certified
Expert objectives are available on
the Web at www.perspection.com.

Logo indicates a
task fulfills one or
more Adobe
Certified Expert
objectives.
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Get More on the Web
In addition to the information in
this book, you can also get more
information on the Web to help
you get up-to-speed faster with
Illustrator CS4. Some of the infor-
mation includes: 

Transition Helpers
◆ OOnnllyy  NNeeww  FFeeaattuurreess..

Download and print the new
feature tasks as a quick and
easy guide.

Productivity Tools
◆ KKeeyybbooaarrdd  SShhoorrttccuuttss..

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. 

More Content
◆ PPhhoottooggrraapphhss.. Download

photographs and other
graphics to use in your
Illustrator documents. 

◆ MMoorree  CCoonntteenntt.. Download
new content developed after
publication.

You can access these additional
resources on the Web at
www.perspection.com.

Additional
content 
is available
on the Web. 
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What You’ll Do

59

Working with Objects

Introduction

Adobe Illustrator is an application that gives you great control
over vector graphics, which include vector shapes and vector
objects. Vector graphics are created using mathematical
shapes, not pixels, and that's why vector shapes are consid-
ered resolution-independent. When you draw a vector object,
you create one or more lines called a path. A path is made up
of one or more curved or straight line segments. The start and
end points for a line segment is known as an anchor point,
which you can drag to change and move. 

Illustrator provides drawing tools on the Tools panel that
you can use to create a variety of shapes, including rectan-
gles, rounded rectangles, ellipses, polygons, stars, flares,
lines, arcs, spirals, rectangle grids, and polar (circular) grids.
After you draw an object, you can use Illustrator selection
tools to modify it. The two main selection tools are the
Selection tool and the Direct Selection tool. The Selection tool
allows you to select entire objects, while the Direct Selection
tool allows you to select paths and segments. In addition to
these tools, you can also use the Select menu. The Select
menu provides a variety of powerful selection commands for
you to use in a document or artboard. For example, you can
select objects whose attributes (including Appearance,
Blending Modes, Fill & Stroke, Opacity, and Stroke Color) are
similar to the current or last selection. 

After you select one or more objects, you can move,
align, group, and transform them. The transformation tools
allow you to rotate, scale (resize), reflect (mirror image), or
shear (slant) an object. 

What You’ll Do

Understand Vector and Raster Images

Understand Paths

Create Rectangle and Ellipses

Create Polygons and Stars

Create Line Segments

Create Arcs and Spirals

Create Grids

Understand Selections

Use the Selection Tool

Use the Direct Selection Tool

Use the Lasso Tool

Use the Magic Wand Tool

Select and Group

Select Similar Objects

Save and Edit Selections

Move and Duplicate Objects

Align and Distribute Objects

Transform Objects

Rotate, Scale, Reflect, or Shear Objects

Apply Multiple Transformations

Reshape Objects with Envelopes
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Illustrator is an application that gives you
great control over vector graphics, which
include vector shapes and vector objects.
Vector graphics are created using mathemati-
cal shapes, not pixels, and that's why vector
shapes are considered resolution-independ-
ent. For example, if you enlarge a vector
image to 100 times its original size, Illustrator
merely changes the mathematical formulas to
reflect the new size, and since vector shapes
are constructed of mathematical data instead
of pixels, file sizes are extremely small.

Raster graphics, such as bitmaps and pho-
tographs, are images creating using individ-
ual pixels that identify one piece of color
information. The reason raster images are
considered resolution-dependent is that once
the image is created or scanned, any enlarge-
ment of the image forces Illustrator to enlarge
and average the existing color information in
the document. This process, called iinntteerrppoollaa--
ttiioonn, is what causes enlarged raster images to
become blurred, or pixelated. 

Understanding Vector and Raster Graphics

Raster Image Vector Image

Close up shows lines Close up shows pixels 
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Chapter 11 Using the Paths Panel 61

When you draw an object, you create one or
more lines called a ppaatthh. A path is made up of
one or more curved or straight lines, known
as sseeggmmeennttss. The start and end points for a
segment is called an aanncchhoorr  ppooiinntt. An anchor
point is a bending point to modify the line
segment. A path can be open or closed. An
open path has open-ended endpoints, such as
a line, while a closed path has connected end-
points, such as a circle. Paths can have two
types of anchor points: smooth points or cor-
ner points. A smooth point connects two
curved segments to create a smooth line,
while a corner point connects two straight or
curved segments to create a path direction
change. You can draw a path using both
smooth and corner points. The outline of a
path is called a stroke, which you can format
with different characteristics. You can specify
stroke weight (thickness), color, or a dashed
pattern. The interior of an open or closed path
is called a fill, which you can also format with
a color or gradient.

You can change the shape of a path by
dragging its anchor point. A selected anchor
point or endpoint appears as a solid square,
while an unselected one appears as a white
square.  When you select an anchor point
with a curved segment, a direction line
appears with direction points on each end,
which you can drag to change the shape of
the path. When you change the shape of a
smooth point with curved segments on each
side, both segments get changed. When you
change a shape of a corner point, the corner
is maintained, but adjusted based on the
change. 

Working with Anchor Points
In Illustrator, you can show or hide anchor
points, direction lines, and direction points by
choosing the VViieeww menu, and then choosing
SShhooww  EEddggeess or HHiiddee  EEddggeess. If you want to
show or hide direction lines for selected
anchor points, select the DDiirreecctt  SSeelleeccttiioonn  tool,
select the anchor point that you want, and
then click SShhooww  HHaannddlleess  FFoorr  MMuullttiippllee  SSeelleecctteedd
AAnncchhoorr  PPooiinnttss or HHiiddee  HHaannddlleess  FFoorr  MMuullttiippllee
SSeelleecctteedd  AAnncchhoorr  PPooiinnttss button in the Control
panel.

You can specify options in the Selection &
Anchor Display preferences to always show
handles when multiple anchor points are
selected (this option is turned off by default).

Understanding Paths IL 2.1

Closed path

Open path
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Creating Rectangles
and Ellipses

Draw an Ellipse or Circle

Select the Ellipse tool on the Tools
panel. 

TIMESAVER Press L to select
the Ellipses tool.

Select a Stroke and Fill Color from
the Colors area of the Tools panel.

Click and drag on the artboard,
and then release the mouse. 

TIMESAVER Press and hold
Shift while you drag to create a
circle.

To create an oval or circle with a
specific width and height, click on
the artboard where you want the
top left corner, enter width and
height values, and then click OK.

4

3

2

1

The Illustrator Tools panel includes several tools for quickly creating
simple geometric vector shapes. They are easy to use; you just click and
drag on the Stage to create the shapes. The Rectangle tool creates rec-
tangles with square or rounded corners. The Ellipse tool creates circular
shapes such as ovals and circles. These shapes can be comprised
either of Strokes, which are lines that surround and define the shape, or
Fills, which can be a color or texture inside the shape, or both.

Did You Know?
You can enter values ranging from 0 to
100 points in the Rounded Rectangle
Settings dialog box. A value of zero
gives you a straight-sided-square.
Higher numbers produce squares with
more rounded sides.

You can draw shapes without a stroke
or a fill. Set either of these properties
to No Fill in the Colors section of the
Tools panel or in the Color panel.

1

2

3

4
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Draw a Rectangle or Rounded
Rectangle  

Click the Rectangle or Rounded
Rectangle tool on the Tools panel. 

TIMESAVER Press M to select
the Rectangle tool.

Select a Stroke and Fill color from
the Colors area of the Tools panel. 

Click and drag on the artboard,
and then release the mouse. 

TIMESAVER Press and hold
Shift while you drag to create a
square.

To create a square, rectangle, or
rounded rectangle with a specific
width and height, click on the
artboard where you want the top
left corner, enter width and height
values, and then click OK.

4

3

2

1

Did You Know?
You can change the corner radius for a
rounded rectangle. While you drag a
rounded rectangle, press the Up Arrow
or Down Arrow key. To create square
corners, press the Left Arrow key. To
create corners with maximum round-
ness, press the Right Arrow key.

You can draw shapes with no stroke
or fill. If you want to draw an oval or a
rectangle without a stroke or fill, you
can set either of these options to No
Fill in the Colors area of the Tools panel
or in the Color Mixer.

You can create a flare shape using the
Flare tool. Select the Flare tool on the
Tools panel, click and drag on the art-
board, and then release the mouse. 

2

1

3

4
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Creating Polygons 
and Stars

Draw a Polygon or Star Shape

Select the Polygon or Star tool on
the Tools panel. 

The pointer becomes a crosshair
that you can drag anywhere on the
artboard.

Select a Stroke and Fill color from
the Colors area of the Tools panel. 

Click and drag on the artboard,
and then release the mouse. 

TIMESAVER Press and hold
Shift while you drag to create a
proportional shape.

To create a shape with a specific
radius and number of sides or
points, click on the artboard where
you want the center of the shape,
enter the following values, and
then click OK.

◆ Polygon. Enter a radius and
number of sides for the
polygon. To create a triangle,
enter 3 sides.

◆ Star. Enter radius 1 for the
distance from the center of the
star to the innermost points and
enter radius 2 for the distance
from the center to the
outermost points.

4

3

2

1

The Polygon and Star tools work in much the same way as the Ellipse
and Rectangle tools do to allow you to easily create complex vector
shapes. You can use these tools to create either polygons and stars.
Polygons are shapes based on a center radius and a number of sides,
while stars are shapes based on two center radiuses: one for the dis-
tance from the center of the star to the innermost points, and another
for the distance from the center to the outermost points. Experiment
with several options to get the kind of shape you want.

1

2

3

Polygon options4

Star options4
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Creating Line
Segments

Draw a Line Segment

Click the Line Segment tool on the
Tools panel. 

The pointer becomes a crosshair
that you can drag on the artboard.

TIMESAVER Press \ to select
the Line tool.

Select a Stroke color from the
Colors area of the Tools panel. 

Click and drag on the artboard,
and then release the mouse when
the line is the length you need. 

TIMESAVER Hold down the
Shift key, and then drag to draw a
45, 90, or 180 degree line. 

To create a line with a specific
length and angle, click on the
artboard where you want the line
to begin, enter length and angle
values, select the Fill Line check
box to fill the line with the current
fill color, and then click OK.

4

3

2

1

The Line Segment tool draws perfectly straight lines in any direction
you drag your mouse. In Illustrator, a line is called a stroke and there is
a variety of thicknesses, styles, colors, and fills that can be applied to it.
You can also create your own line style for specific types of dashed,
dotted or artistic lines. You can constrain the path a line draws to 45-
degree angles or create closed shapes by intersecting the lines you
draw.

2

1

3

4
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Creating Arcs and
Spirals

Draw an Arc

Click the Arc tool on the Tools
panel. 

The pointer becomes a crosshair
that you can drag on the artboard.

Select a Stroke color from the
Colors area of the Tools panel. 

Click and drag on the artboard,
and then release the mouse when
the arc is the length you need. 

To create an arc with specific
settings, click on the artboard
where you want the arc to begin,
enter x and y lengths, specify type
(open or closed), arc direction
(Base Along) and slope options,
select the Fill Arc check box to fill
the arc with the current fill color,
and then click OK.

4

3

2

1

The Arc and Spiral tools make it easy to create unique and interesting
shapes. These tools draw curved lines to create an individual arc or a
Spiral wind. An arc consists of an x and y axis length, open or closed
path, arc direction (known as the Base Along), arc slope, and arc fill
(optional). A Spiral consists of a radius from the center to the outermost
point in the Spiral, decay (the amount each wind decreases), number of
segments for the spiral, and Spiral style. Each full wind of a Spiral con-
sists of four segments.

2

1

3

4
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Draw a Spiral

Click the Spiral tool on the Tools
panel. 

The pointer becomes a crosshair
that you can drag on the artboard.

Select a Stroke color from the
Colors area of the Tools panel. 

Click and drag on the artboard,
and then release the mouse when
the Spiral is the length you need. 

To create a Spiral with specific
settings, click on the artboard
where you want the Spiral to
begin, enter a radius (distance)
from the center to the outermost
point, decay percentage (amount
of the wind decreases), the
number of segments, and style
options, and then click OK.

4

3

2

1

2

1

3

4
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Creating Grids

Draw Rectangle Grids

Click the Rectangle Grid tool on
the Tools panel. 

The pointer becomes a crosshair
that you can drag on the artboard.

Select a Stroke color from the
Colors area of the Tools panel. 

Click and drag on the artboard,
and then release the mouse when
the grid is the size you need. 

To create a grid with specific
settings, click on the artboard
where you want the grid reference
point, enter a width and height for
the grid, specify the number of
horizontal and vertical dividers,
select the Use Outside Rectangle
As Frame check box to replace
individual segments with a
separate rectangle object, select
the Fill Grid check box to fill the
grid with the current fill color, and
then click OK.

4

3

2

1

The grid tools on the Tools panel allow you to create a rectangular or
circular polar grid. The Rectangular Grid tool creates rectangular grids
of a specified size and number of horizontal and vertical dividers. The
Polar Grid tool creates concentric circles of a specified size and spe-
cific number of concentric and radial dividers.

2

1

3

4
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Draw Circular Polar Grids

Click the Polar Grid tool on the
Tools panel. 

The pointer becomes a crosshair
that you can drag on the artboard.

Select a Stroke color from the
Colors area of the Tools panel. 

Click and drag on the artboard,
and then release the mouse when
the grid is the size you need. 

To create a grid with specific
settings, click on the artboard
where you want the grid reference
point, enter a width and height for
the grid, specify the number of
concentric and radial dividers,
select the Create Compound Path
From Ellipses check box to
replace circles with separate
compound paths, select the Fill
Grid check box to fill the grid with
the current fill color, and then 
click OK.

4

3

2

1

2

1

3

4

C03ILCS4.qxp  11/5/2008  1:22 AM  Page 69



70

When you create vector graphics in Illustrator,
they are comprised of distinct segments that
can be selected separately or as a whole with
a variety of selection tools. The type of editing
you need to perform determines which tool
you use. For example, a simple rectangle is
comprised of four line segments that sur-
round the contour of the shape and one fill in
the center. Each of these parts can be selected
as a group with the SSeelleeccttiioonn tool or individu-
ally with the DDiirreecctt  SSeelleeccttiioonn tool. To select an
object using the fill, you need to deselect the
Object Selection by Path Only check box in
Selection & Anchor Display preferences.

In addition to the Selection and Direct
Selection tools, you can also use the GGrroouupp
SSeelleeccttiioonn tool to select all the anchor points
on a single path. With the Group Selection

tool, click to select an object, click twice to
select the object’s group, and click three times
to select the group within the group (if avail-
able). The Group Selection tool is useful for
working with multiple objects. If you want to
work with an individual object without affect-
ing other objects, it’s better to use Isolation
Mode. 

The LLaassssoo tool is a classic selection tool
that allows you to select path points and seg-
ments by dragging a freeform marquee
around them. 

The MMaaggiicc  WWaanndd tool allows you to select
objects of the same or a similar fill color,
stroke color, stroke weight, opacity, or blend-
ing mode.

Understanding Selections IL 2.8

Selection preferences

Group selection tool

Selection tool

Lasso tool

Direct Selection tool

Magic
Wand

tool
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Using the Selection 
Tool

Select an Object with the
Selection Tool 

Click the Selection tool on the
Tools panel. 

The pointer becomes an arrow.

TIMESAVER Press V to select
the Selection tool.

Position the arrow on the edge of
the object, and then click it. 

◆ You can also drag a marquee
across all or part of the object
to select the entire path.

◆ If the path has a color fill,
appears in Preview mode, and
the Object Selection by Path
Only check box is deselected in
Selection & Anchor Display
preferences, you can also click
the fill to select the object.

To add or subtract objects from the
selection, hold down the Shift key,
and then click unselected objects
to add or click selected objects to
subtract them from the selection.

3

2

1

There are several ways to select objects in Illustrator. With the
Selection tool, you can select an object's stroke or fill. You can only
select an object using the fill if the path appears in Preview mode, and
the Object Selection by Path Only check box is deselected in Selection
& Anchor Display preferences. After you select one or more objects,
you can add or subtract objects to/from the selection. In addition, you
can use the Selection tool and drag a marquee to select parts of the
object or drag over a portion of it to create a selection rectangle.

IL 2.8

1

2

3

C03ILCS4.qxp  11/5/2008  1:22 AM  Page 71



72

Using the Direct
Selection Tool

Select Anchor Points and
Segments with the Selection
Tool 

Click the Direct Selection tool on
the Tools panel. 

The pointer becomes an arrow.

TIMESAVER Press A to select
the Direct Selection tool.

Position the arrow on the edge of
the path and click to select a
segment, and then click an anchor
point to select it.

◆ You can also select an anchor
point directly. Pass the pointer
over a path and then point to an
anchor point and then click it.

◆ You can also drag a marquee
across all or part of the object
to select the entire path.

To add or subtract anchor points
or segments from the selection,
hold down the Shift key, and then
click unselected items to add them
or selected items to subtract them
from the selection.
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With the Direct Selection tool, you can select individual points and seg-
ments of a path. After you select one or more individual points and seg-
ments, you can add or subtract items to/from the selection. In addition,
you can also use the Direct Selection tool and drag a marquee to select
parts of the path or drag over a portion of it to create a selection rec-
tangle.

IL 2.8
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Using the Lasso Tool

Select with the Lasso Tool

Click the Lasso tool on the Tools
panel. 

Draw around the shapes you want
to select. 

To complete the selection, return
to the point where you started.  
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1

Use the Lasso tool when you want to select shapes that are very close
to shapes you don't want to select. This tool allows you to draw around
the shape, selecting everything contained within the drawn area. When
you draw a selection, you can drag across a path to include it in the
selection instead of dragging completely around it. This selection tool is
useful when you are working with overlapping paths.

Did You Know?
You can select single or multiple
objects. Holding the Shift key adds line
segments and fills them. Shift-clicking
selected items deselects them. 

IL 2.8
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The Magic Wand tool (so named since it looks like a magic wand) is
unique in the fact that you do not drag and select with this tool; you
simply click. The Magic Wand tool creates a selection based on the
shift in brightness ranges within an image. If there is a definable shift in
the brightness of the pixels, it can be a very powerful tool for the selec-
tion of odd-shaped areas. To use the Magic Wand, click on the Magic
Wand Tool button on the Tools panel.

Using the Magic 
Wand Tool

Select Options for the Magic
Wand Tool

Double-click the Magic Wand tool
on the Tools panel.

◆ You can also click the Window
menu, and then click Magic
Wand to display the panel.

Click the Options menu, and then
select the Show Stroke Options
and Show Transparency Options
(if necessary) to display them in
the Magic Wand panel.

◆ You can also click the double-
arrow next to the Magic Wand
title to display options.

Select the check box for the
attributes that you want the Magic
Wand to select. The options
include: Fill Color, Stroke Color,
Stroke Weight, Opacity, or
Blending Mode. 

Enter a Tolerance value (0 to 255).
The higher the value, the more
information the Magic Wand tool
selects.

To select objects on all layers,
click the Options menu, and then
select Use All Layers to check it.
Select it again to select objects
only on the current layer.

To reset all fields in the Magic
Wand panel, click the Options
menu, and then click Reset.
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Use the Magic Wand Tool

Select the Magic Wand tool on the
Tools panel.

Click an object area to make a
selection.

Depending on the options you
selected in the Magic Wand panel,
other objects with the same or
similar attributes (fill color, stroke
color, stroke weight, opacity, or
blending mode) are selected.

To add to the selection, hold down
the Shift key, and then click
another unselected object. 

To subtract from the selection,
hold down the Alt (Win) or Option
(Mac) key, and then click a
selected object.
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Selecting and grouping objects makes it easier to work with multiple
objects as if they were a single object. You can easily select, isolate,
cut, copy, paste, move, recolor, and transform a grouped object. You
can group all types of objects, yet still edit individual objects within the
group as needed without having to ungroup them first by using
Isolation Mode. Illustrator places a grouped object on the top level of
the top object in the group and uses the same selection color. If you no
longer need to group objects, you can ungroup them. 

Selecting and
Grouping

Create a Group

Select the Selection tool on the
Tools panel.

Use a selection method to select
the objects that you want in the
group.

Click the Objects menu, and then
click Group.

◆ You can use the Group
command again to group
objects already in a group; this
is known as a nested group. 

Ungroup Objects

Select the Selection tool on the
Tools panel.

Select the grouped objects that
you want to ungroup.

Click the Objects menu, and then
click Ungroup.

◆ If you have nested groups
within an object, you can use
the Ungroup command again to
ungroup it. 
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Use Isolation Mode to Work
with Groups

Select the Selection tool on the
Tools panel.

Double-click a grouped object.

◆ You need to click the Isolate
Selected Group button on the
Control panel or select the
Double-click to Isolate check
box in General preferences.

A gray bar appears with the name
of the group at the top of the
document window. All objects
outside the group are dimmed out
and uneditable. The words
“Isolation Mode” also appear on
the Layers panel.

Edit individual objects or add new
objects to the group.

To exit Isolation Mode, click the
gray bar. 
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The Select menu provides a variety of powerful selection commands
for you to use in a document or artboard. In addition to the common
commands, such as All, Deselect, and Inverse, you can also select
objects whose attributes (including Appearance, Blending Modes, Fill &
Stroke, Opacity, and Stroke Color) are similar to the current or last
selection. For more selection power, you can select objects based on
the object type (including All on Same Layers, Direction Handles, Brush
Strokes, Clipping Masks, Stray Points, Text Objects).

Selecting Similar
Objects

Use the Select Menu to Select
Objects

Click the Select menu.

Select the command that you
want:

◆ All. Selects all objects in the
document. 

◆ All in Active Artboard. Selects
all objects in the active
artboard. 

◆ Deselect. Deselects all objects
in the document.

◆ Reselect. Reselects the most
recent selection.

◆ Inverse. Inverses the current
selection.

◆ Next Object Above. Selects the
next object above the current
selection. 

◆ Next Object Below. Selects the
next object below the current
selection. 

2
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Select Similar Objects or Object
Attributes

Select an object on which to base
the new selection or deselect all
objects to base the new selection
on the last selected object.

Click the Select menu, and then
point to Same or Object.

Choose the command that you
want to use to make a selection.

Select Objects in the Layers
Panel

Open the Layers panel.

Click the expand/collapse triangle
to display the layer that you want
to select.

Click the selection area on the
right side of the layer in the Layers
panel that has the object that you
want to select.

◆ You can also click the Select
menu, point to Object, and then
click All on Same Layers to
select all on a layer. 
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If you frequently select the same elements in a document, you can save
yourself some time by saving the selection with a name of your choice.
After you save a selection, the saved selection name appears as a
menu command at the bottom of the Select menu. When you need to
make the same selection, simply choose the command. When you no
longer use a saved selection, you can delete it. 

Saving and Editing
Selections

Save and Use a Selection

Make the selection that you want
to save.

Click the Select menu, and then
click Save Selection.

Enter a name for the selection.

Click OK.

Click the Select menu, and then
click the name of the saved
selection at the bottom of the
menu.

Edit a Saved Selection

Click the Select menu, and then
click Edit Selection.

Select the saved selection that
you want to rename or delete.

To delete a saved selection, click
Delete.

To rename a saved selection,
change the name in the Name box.

Click OK.5
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Moving an object or group of objects is very easy. The simplest way is
to drag the edge of an object in Outline or Preview view. If you want to
constrain the movement of the object in multiples of 45 degrees, then
use the Shift key as you drag. While you drag an object, Smart Guides
appear automatically to make it easier for you to align objects with
other objects. 

Moving Objects

Move an Object

Select the Selection tool on the
Tools panel.

Select one or more objects that
you want to move.

Drag the edge of an object.

◆ To constrain the movement of
the object to multiples of 45
degrees or the current angle in
General preferences, hold
down the Shift key as you drag. 

◆ If the path has a color fill,
appears in Preview mode, and
the Object Selection by Path
Only check box is deselected in
Selection & Anchor Display
preferences, you can also click
the fill to select the object.
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See Also
See “Using Smart Guides” on page 50
for more information on setting Smart
Guide preferences and using Smart
Guides.

Did You Know?
You can delete an object. Select the
object that you want to delete, and
then press Delete, or click the Edit
menu, and then click Clear. 
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Duplicating objects can be a powerful way of creating geometrical art-
work. You can duplicate one or more selected objects by dragging
them, using Arrow keys, copying to and pasting from the Clipboard, or
using the Offset Path command. The Offset Path command duplicates a
path (along with fill and stroke attributes) and places it on the artboard
based on the offset distance specified in the Offset Path dialog box.
The duplicate path is reshaped to fit around the original path.  

Duplicating Objects

Duplicate Objects

Select the Selection tool on the
Tools panel.

◆ If the object is in a group,
select the Direct Selection tool
on the Tools panel.

Use any of the following methods:

◆ Same Document. Hold down Alt
(Win) or Option (Mac), and then
drag the edge or fill of the
object. 

◆ Different Documents. Open the
documents side by side, and
then drag the edge or fill of the
object from one document to
another. 

◆ Clipboard. Select the object,
click the Edit menu, and then
click Copy. Click in the target
document or artboard, click the
Edit menu, and then click
Paste, Paste in Front, or Paste
in Back.

◆ Keyboard. Select the object,
press Control (Win) or
Command (Mac) key, and then
use one of the Arrow keys to
move the duplicated object in
the direction you want. The
duplicate object moves away
from the original object based
on the current keyboard
increment value in General
preferences.
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Duplicate Objects Using an
Offset

Select the Selection tool on the
Tools panel.

Select an object.

Click the Object menu, point to
Path, and then click Offset Path.

Enter the distance you want to
offset the duplicate path from the
original object.

Click the Joins list arrow, and then
select a bend style: Miter
(pointed), Round (circular), or
Bevel (square-cornered)

You can set a limit (1-500) to
determine when a mitered corner
changes into a beveled corner. A
low number creates a more
beveled corner, while a high
number creates a sharper corner.

Click OK.7
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Aligning and
Distributing Objects

Align or Distribute Objects

Select the Selection tool on the
Tools panel.

Select two or more objects to align
them or select three or more
objects to distribute them.

Select the Align panel or click
Align on the Control panel.

Click the Options menu, and then
click Use Preview Bounds. A
checked option uses he object’s
stroke weight and any applied
effects when aligning or
distributing.

If you want to align objects along
the edges of the artboard, click the
Align To menu on the Align or
Control panel, and then click Align
to Artboard. Objects are moved on
the artboard based on the
alignment or distribution command
to the closest edge (top and
bottom, or left and right). 

If you want to align objects to a
key object, click an object to make
it the key object (a thick blue
outline appears and the Align To
Key Object option is selected in
the Align and Control panel).  

Use the alignment and distribution
buttons on the Align or Control
panel.
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In addition to using grids and guides to align objects to a specific point,
you can align a group of objects to each other. The Align panel buttons
make it easy to align two or more objects relative to each other or to
the page. To evenly align several objects to each other across the doc-
ument, either horizontally or vertically, select them and then choose a
distribution option. Before you select an align command, specify how
you want Illustrator to align the objects. You can align the objects in
relation to the document or to the selected objects. If you want to align
all the objects to another object, you can select and use a key object
(New!), before you select an alignment option. 

IL 2.7
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Transforming Objects

Transform an Object with the
Bounding Box

Click the View menu, and then
click Show Bounding Box to
display it.

Select the Selection tool on the
Tools panel.

Select one or more objects to
transform.

Use any of the following methods:

◆ Scale. Drag a corner handle to
scale along two axes; drag a
side handle to scale along one
axis; Shift-drag to scale
proportionally; hold down Alt
(Win) or Option (Mac), and then
drag to scale from the center.
Also hold down Shift to scale
from the center proportionally.

◆ Reflect. Drag a side handle all
the way across the object to
the other side. 

◆ Rotate. Point slightly outside a
corner handle (pointer changes
to a double arrow), and then
drag in a circular motion. 

To rotate an object 180
degrees, drag a corner handle
diagonally all the way across
the object.
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The easiest way to transform an object is to use the bounding box. With
the bounding box, you can quickly scale (resize), reflect (mirror), and
rotate an object. However, you cannot copy an object or move the ref-
erence point. As you drag to transform an object, you can use keyboard
keys to alter the results of a transformation. Experiment with the differ-
ent options to create some new results.

IL 2.9
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Using the Free
Transform Tool

Transform an Object with the
Free Transform Tool

Select the Free Transform tool on
the Tools panel.

Select one or more objects to
transform.

Use any of the following methods:

◆ Scale. Drag a corner handle to
scale along two axes; drag a
side handle to scale along one
axis; Shift-drag to scale
proportionally; hold down Alt
(Win) or Option (Mac), and then
drag to scale from the center.
Also hold down Shift to scale
from the center proportionally.

◆ Reflect. Drag a side handle all
the way across the object to
the other side. 

◆ Rotate. Point slightly outside a
corner handle (pointer changes
to a double arrow), and then
drag in a circular motion. To
rotate in 45 degree increments,
Shift-drag. 

To rotate an object 180
degrees, drag a corner handle
diagonally all the way across
the object.

◆ Shear. Drag a side handle and
then hold down Ctrl (Win) or
Command (Mac) as you
continue to drag. To constrain
the movement, also press Shift.
To shear from the center, also
press Alt (Win) or Option (Mac). 
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The Free Transformation tool allows you to rotate, scale (resize), reflect
(mirror image), or shear (slant) an object. In addition, you can apply
perspective and distortion to an object. However, you cannot copy an
object or move the reference point. As you drag to transform an object,
you can use keyboard keys to alter the results of a transformation. To
help you align the results the way you want, you can use Smart Guides
to make it easier.  

IL 2.9
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◆ Perspective. Drag a side
handle and then hold down
Ctrl+Alt+Shift (Win) or
Command+Option+Shift (Mac)
as you continue to drag. 

◆ Distort. Drag a corner handle
and then hold down Ctrl (Win)
or Command (Mac) as you
continue to drag. 

To use Smart Guides as you
transform an object:

◆ Select the Transform Tools
check box in Smart Guides
preferences.

◆ Click the View menu, and then
click Smart Guides to display
them.

◆ As you drag to transform an
object, smart guides appear  in
your document, which you can
use to align the transformed
object.

4
Perspective

Perspective
results
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Rotating and Scaling
Objects

Rotate or Scale an Object

Select the Selection tool on the
Tools panel.

Select one or more objects to
transform.

Select the Rotate or Scale tool on
the Tools panel.

To move the reference point, click
a new point.

Use the appropriate method:

◆ Rotate. Drag in a circular
motion. To rotate in 45 degree
increments, Shift-drag. 

◆ Scale. Drag away from or
toward the object. Shift-drag to
scale proportionally; hold down
Alt (Win) or Option (Mac), and
then drag to scale from the
center. Also hold down Shift to
scale from the center
proportionally.

◆ Scale and Flip. Drag across the
entire object. 

◆ Scale and Copy. Hold down
Alt+Shift (Win) or Option+Shift
(Mac), and then drag. 

To rotate or scale an object using
exact values or percentages, use
the Transform panel. If the
Transform panel is not visible,
select it from the Window menu.

6

5

4

3

2

1

After you create an object, you can change its orientation by rotating it
or change its size by scaling it. For a freeform rotation, when you want
to rotate the object in other than 90 or 180 degree increments, you can
use the Rotate tool. To resize an object, either smaller or larger, you can
use the Scale tool. With either tool, you can transform the object from
its center or the reference point. To rotate or scale an object using
exact values or percentages, use the Transform panel, which is avail-
able on the Control panel or Window menu.

IL 2.9
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Reflecting and
Shearing Objects

Reflect or Shear an Object

Select the Selection tool on the
Tools panel.

Select one or more objects to
transform.

Select the Reflect or Shear tool on
the Tools panel.

To move the reference point, click
a new point.

Use the appropriate method:

◆ Reflect. Click to establish a
reference point, and then click
again to establish the axis of
reflection. 

◆ Shear. Drag away from the
object.

To reflect or shear an object using
exact values or percentages, use
the Transform panel.
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The Reflect and Shear tools on the Tools panel allow you to be creative
as you transform an object. The Reflect tool creates a mirror image of
an object, while the Shear tool creates a slanted image of an object. To
reflect or shear an object using exact values or percentages, open the
Transform panel, which is available on the Control panel or Window
menu.

IL 2.9
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Applying Multiple
Transformations

Use the Transform Each
Command

Select the Selection tool on the
Tools panel.

Select one or more objects to
transform.

Click the Object menu, point to
Transform, and then click
Transform Each.

Select the Preview check box to
view your changes on the selected
object.

Do any of the following:

◆ Scale Horizontal or Vertical.
Drag the slider or enter a
percentage to scale objects
from their reference point.

◆ Move Horizontal or Vertical.
Drag the slider or enter a
percentage to move objects left
or right and up or down.

◆ Rotate Angle. Enter a rotate
angle or drag the dial. 

◆ Reflect X or Y. Select to create
a mirror reflection of the
objects.

◆ Reference Point. Click a square
to change the reference point. 

◆ Random. Select to apply
random transformations using
the values in the dialog box. 

Click OK or Copy (creates a copy
and applies the transformation).
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The Transform Each command allows you to transform multiple objects
relative to their individual reference points instead of a single reference
point. With the Transform Each command, you can scale or move
objects horizontally or vertically, rotate objects by a specific angle, and
create a mirror reflection of the objects. If you want to create a unique
effect, you can also have Illustrator apply random transformations. You
can also use the Transform Effect command to create similar effects,
which you can modify. 

IL 2.9
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Use the Transform Effect

Select the Selection tool on the
Tools panel.

Select one or more objects to
transform.

Click the Effect menu, point to
Distort & Transform, and then click
Transform.

Select the Preview check box to
view your changes on the selected
object.

Do any of the following:

◆ Scale Horizontal or Vertical.
Drag the slider or enter a
percentage to scale objects
from their reference point.

◆ Move Horizontal or Vertical.
Drag the slider or enter a
percentage to move objects left
or right and up or down.

◆ Rotate Angle. Enter a rotate
angle or drag the dial. 

◆ Copies. Enter the number of
copies you want.

◆ Reflect X or Y. Select to create
a mirror reflection of the
objects.

◆ Reference Point. Click a square
to change the reference point. 

◆ Random. Select to apply
random transformations using
the values in the dialog box. 

Click OK.

To edit the transformation, select
the object, and then click
Transform on the Appearance
panel.
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Repeating a Transformation
The Transform Again command allows you to quickly repeat the last
transformation with the last-used values on a selected object. To use
the command, transform and select an object or group, click the
Object menu, point to Transform, and then click Transform Again or
press Ctrl+D (Win) or Command+D (Mac).

For Your Information
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Transformation
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Reshaping Objects
with Envelopes

Distort Objects with an Envelope

Select the Selection tool on the
Tools panel.

Select one or more objects to
reshape.

Click the Object menu, point to
Envelope Distort, and then click
one of the following:

◆ Make With Warp. Uses a
preset warp shape.

◆ Make with Mesh. Uses a
rectangle grid.

◆ Make With Top Object. Uses an
object as the shape of the
envelope. The object needs to
be at the top of the stacking
order. 

Specify the options you want for
the envelope type; select the
Preview check box to view your
changes on the selected object.

Click OK.

Do any of the following:

◆ Reshape. Select the Selection
or Mesh tool, and then drag
any anchor points. 

◆ Delete Anchor Points. For a
mesh grid, Select the Selection
or Mesh tool, select an anchor
point, and then press Delete.

◆ Add Anchor Points. For mesh
grid, select the Mesh tool, and
then click on the grid. 
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Envelopes are objects you can use to reshape other objects, except
graphs, guides, or linked objects. You can use one of the built-in
envelopes or create your own out of an existing object. The built-in
envelopes use warp shapes or a mesh grid as the object. After you
apply an envelope, you can edit the original object or the envelope
(anchor points), separately, using the Selection and Mesh tools on the
Tools panel.

IL 6.2, 6.7
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Mesh grid
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Index

A
accented edges effects, 257
actions

Actions panel, 308–309
adding commands to, 314
adding stops to, 312
batch file processing, 316–317
building new, 310
built-in scripts, 318
controlling playback of, 311
deleting commands from, 315
inserting a non-recordable command in

an Action, 313
order of commands in, changing, 314
recording, 310
running actions within actions, 310
saving

as files, 309
into sets, 309

scripts, 318–319
activation, 2
active documents, 19
active windows, 18
Adobe Bridge

automating tasks in, 418
browsing documents with, 14
Camera Raw feature, 410–411
color settings, 95
components of, 407
description of, 406
editing images in, 416
Get Photos from Camera command, 409
opening documents with, 14–15, 408
placing graphics from, 222–223
preferences, setting, 414–415
revealing documents in, 14
Web Photo Gallery creation, 417

working with images using, 15, 412–413
Adobe ConnectNow, 406, 419
Adobe Device Central

basic description of, 406, 422
checking content using, 423
components of, 422

Adobe Drive, 406, 421
Adobe Extension Manager, 406, 424
Adobe Flex File, saving documents as, 360
Adobe PDF Presets command (Edit menu),

353
Adobe Product Improvement Program, 23
Adobe Studio Exchange, 2
Adobe Updater, 21
Adobe Version Cue

basic description of, 406
file management, 420

Adobe Web site
Adobe Studio Exchange, 2
Community Help, 22

advanced print options, 340–341
Advanced tab (File Info dialog box), 345
alignment

anchor points, 148–149
objects, 84
paragraphs, 208
slices, 383
stroke, 120

All Objects command (Select menu), 78
All Objects in Active Artboard command

(Select menu), 78
anchor points

adding new, 146–147
alignment, 148–149
Convert Anchor Point tool, 145
converting, 144–145
deleting, 147
direction lines, 142
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aanncchhoorr  ppooiinntt  ((ccoonnttiinnuueedd))
endpoints, 149
highlighting, 142
moving, 142–143
paths and, 61
preferences, 142
selecting with Direct Selection tool, 72
showing and hiding, 61
smooth points, converting to corner

points, 144
anchors, 393
anti-aliasing, 390
Appearance of Black preferences, 402
Appearance panel, 236–237
Arc tool, 66
arcs, drawing, 66
area graphs, 322
Area Type tool, 189
arranging

documents, 18
layers, 174–175
slices, 382–383

art brushes, 280–281
Artboard tool

artboard creation, 34
Artboard Options button, 35
multiple artboards, 36

artboards
within artboards, 34
aspect ratio, 35
centerpoints, 35
deleting, 36
display options, 37
duplicating, 34
exiting editing mode, 34
landscape/portrait orientation, 35
moving, 36
multiple, working with, 36
navigating within, 34
presets, 34
previewing, 36
resizing, 36
rotating, 36
size, 35
switching between, 17, 37
video safe areas, 35
X and Y positioning, 35

artwork, inserting in documents, 16
Assign Profile command (Edit menu), 96
attributes

appearance, 236–237
stroke, 120–121

Audio Data tab (File Info dialog box), 344
auto slices, 378
AutoCAD drawing format, 349
AutoCAD File format, 349

B
bar graphs, 322
batch file processing, 316–317
Batch Rename command, 418
bend styles, 83
bevel bend style, 83
bevel joins, 121
bitmap, exporting documents as, 350
black appearance options, 402
bleed

bleed print option, 335
document creation, 32

Blend command (Objects menu), 127–128
Blend tool, 129
blends

blending fill colors, 126
changing and applying blend options,

128
creating automatically, 127
creating with Blend tool, 129
making and releasing blend objects, 127
objects, modifying, 130
opacity, 131
transformation, 130
transparency settings, 132

Bloat tool, 286
Blob Brush tool

brush options, setting, 155
merging paths with, 154

blur effects, 252
BMP format, 349
bold font, 200
Bounding Box command (View menu),

270–271
Bridge (Adobe)

automating tasks in, 418
browsing documents with, 14

Z00ILCS4.qxp  11/5/2008  1:44 AM  Page 442



Index 443

Camera Raw feature, 410–411
color settings, 95
components of, 407
description of, 406
editing images in, 416
Get Photos from Camera command, 409
opening documents with, 14–15, 408
placing graphics from, 222–223
preferences, setting, 414–415
revealing documents in, 14
Web Photo Gallery creation, 417
working with images using, 15, 412–413

Browse in Bridge command (File menu),
14–15, 222–223

brushes
art, 280–281
Blob Brush tool, 155
Brushes panel, 273
calligraphic, 278–279
deleting, 284
Paintbrush tool, 274–275
pattern, 282–283
scatter, 276–277
strokes, removing, 284

Brushes panel, 273
built-in scripts, actions, 318

C
calligraphic brushes, 278–279
Camera Data tab (File Info dialog box), 344
Camera Raw feature, 410–411
caps, 121
case, text, 329
Categories tab (File Info dialog box), 344
center mark, 37
centerpoints, 35
Check Spelling command (Edit menu), 324
circles, drawing, 62
clearing

guides, 49
objects, 81

clipping masks
creating, 160
creating for groups or layers, 161
editing, 162
masked object, editing in Isolation

Mode, 163

release objects from, 161
clipping sets, 163
Close button, 26
Close command (File menu), 26
closed paths, 61
closing

documents, 26
Illustrator, 26
panels, 7

CMYK (Cyan, Magenta, Yellow and Black)
color mode, 28, 97, 101

collapsing panels, 7
Color Guide panel

applying color with, 112–113
color groups, 113
harmony rules, variations based on, 113
variation options, selecting, 111
variation types, displaying, 111

color management print options, 342
color modes. See also colors

changing, 98
CMYK, 28, 97, 101
document creation, 28
Grayscale, 28, 100
RGB, 28, 97, 100
switching between, 97
working with, 97

Color panel
Color sliders, 100
working with, 100–101

colored paper simulation, 33
colors. See also Color Guide panel; color

modes; Swatches panel
applying to objects, fills, or stroke, 99,

118
applying with Eyedropper tool, 122–123
Color Guide Panel, 111–113
Color panel, 100–101
color profiles, changing or removing, 95
color settings, changing, 94–95
converting to grayscale, 109
crop mark registration color, 54
gamut warning icon, 101
global, 108–110
grayscale images, 109
grid colors transparency settings, 33
grids, 52
guides, 48, 51
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hue, 101
inverting, 110
Kuler panel, 106–107
Live Color feature, 114–115
luminosity, 101
nonglobal, 108–110
proofing, 116
replacing, 108–109
saturation, 101
selecting, 101
soft proof, 116
Swatches panel, 102–105
themes, 106–107
view box color, 42
Web-safe, 101

column graphs, 322
commands

adding to actions, 314
basic description of, 6
deleting from actions, 315
Panel Options menu, 9

Community Help site, 22
compound paths

creating, 158
releasing, 159
reversing object's fill in, 159

condensed font, 200
ConnectNow (Adobe), 406, 419
Constrain Angle general preference, 390
Control panel

anchor points, converting, 145
basic description of, 11
splitting paths using, 153
tools in, 6

Convert Anchor Point tool, 145
Convert to Shape command (Effect menu),

242
convert to shape effects, 242
converting anchor points, 144–145
Copy command (Edit menu), 197
copying text, 196–197
corner points, 144
Corner Radius general preference, 390
Create New Action button (Actions panel),

309
Create New Set button (Actions panel), 309

crop marks
creating, 54
deleting, 54
general preferences, 391
registration color, 54

cross hairs, 37
Crystallize tool, 286
cursor preferences, 390
curved segments, 143
curves, drawing, 141
custom dictionaries, spell checking, 325
Cut command (Edit menu), 197
cutout effects, 256

D
dashed stroke, 121
data graphs, 322
data sets

creating, 320–321
deleting, 320–321
renaming, 321

data variables, 320–321
Define Pattern command (Edit menu), 124
Delete button (Actions panel), 309
deleting

anchor points, 147
artboards, 36
brushes, 284
commands from actions, 315
crop marks, 54
data sets, 320–321
files, 12
graphic styles, 235
layers, 171
objects, 81
selections, 80
slices, 380
symbols, 291
workspaces, 57

Description tab (File Info dialog box), 344
Deselect command (Select menu), 78
Device Central (Adobe)

basic description of, 406
checking content using, 423
components of, 422

Device Central command (File menu), 39
DICOM tab (File Info dialog box), 345

Z00ILCS4.qxp  11/5/2008  1:44 AM  Page 444



Index 445

dictionaries, spell checking, 325
diffuse glow effects, 257
Direct Selection tool

anchor points, adding new, 146
anchor points or segments, moving, 143
deleting anchor points using, 147
editing patterns using, 125
end points, connecting, 149
selecting anchor points and segments

with, 72
showing/hiding direction lines, 61
understanding selections, 70

direction lines
anchor points, 142
showing and hiding, 61

Distort & Transform command (Effect
menu), 90

distributing
objects, 84
slices, 383

dithering, 373
dividing paths, 153
DOC format, 193
docking

documents, 19
panels, 8

Document Color Mode command (File
menu), 98, 330

Document Info panel, 346
Document Setup command (File menu), 32,

133
Document window, 6
documents

active, 19
arranging, 18
bleed and view options settings, 32
browsing with Adobe Bridge, 14
closing, 26
color modes, 28
creating

from scratch, 28
from templates, 30–31
using presets, 29

docking/undocking, 19
exporting

as bitmap, 350
Export command, 348
export file formats, 349

as Flash Movie, 354–355
to Photoshop, 352
with presets, 353
as TIFF format, 351

file information, inserting, 344–345
finding and replacing text and elements

in, 326–327
grid pattern, 19
inserting images in, 16
language settings, 33
linking, 16
measurement units, 32
opening

with Adobe Bridge, 14–15
existing documents, 12
recently opened, 13
from Welcome Screen, 13

printing, 330
revealing in Adobe Bridge, 14
rulers, 46–47
saving, 24–25

as Adobe Flex File, 360
as EPS format, 358–359
as FXG format, 360
as Microsoft Office, 361
as PDF format, 356–357
as template, 362
for the Web, 364–365

setting up, 32–33
spell checking, 324–325
switching between, 18
tabbed, 18
templates, 16
transparency settings, 32–33
type options settings, 33
view size, 17
viewing information in, 17
views, 38–41
windows, 18–19
working with multiple, 18–19

DOCX format, 193
double quotes, 33
drawing

arcs, 66
circles, 62
curves, 141
ellipses, 62
line segments, 65

Z00ILCS4.qxp  11/5/2008  1:44 AM  Page 445



446
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with Pencil tool, 260–261
polygons, 64, 140
rectangle grids, 68
rectangles, 63
spirals, 66–67
stars, 64

drawing tablets, 404
Drive (Adobe), 406, 421
drop shadow effects, 245
duplicating

artboards, 34
color in Swatches panel, 103
graphic styles, 233
layers, 176
objects, 82–83
slices, 380
symbols, 292

E
Edit Colors command (Edit menu), 110, 126
Edit Custom Dictionary command (Edit

menu), 325
Edit menu commands

Adobe PDF Presets, 353
Assign Profile, 96
Check Spelling, 324
Color Settings, 94
Copy, 197
Cut, 197
Define Pattern, 124
Edit Colors, 110, 126
Edit Custom Dictionary, 325
Find and Replace, 326–327
Paste, 196–197
Paste in Back, 197
Paste in Front, 197
Print Presets, 331
Redo, 58
Transparency Flattener Presets, 341
Undo, 58

Edit Selection command (Select menu), 80
Edit View command (View menu), 38
editing

blend objects, 130
clipping masks, 162
color in Swatches panel, 103

colors with Live Color, 114–115
gradients, 136
graphic styles, 234
images in Adobe Bridge, 416
paths within clipping sets, 163
patterns, 125
selections, 80
symbols, 293

Effect menu commands
Convert to Shape, 242
Crop Marks, 54
Distort & Transform, 90
Effect Gallery, 254–255
Sharpen, 253
Stylize, 243

effects
accented edges, 257
applying multiple, 254
blur, 252
controlling with selections, 255
convert to shape, 242
cutout, 256
diffuse glow, 257
drop shadow, 245
dry brush, 256
Fresco, 256
gaussian blur, 252
glass, 257
glowing edges, 257
grain, 258
graphic pen, 258
Illustrator, 240–241
inner glow, 244–245
mosaic tiles, 258
note paper, 257
outer glow, 244–245
panel knife, 256
Photoshop Effect Gallery, 250–251
plastic wrap, 258
previewing, 240
raster graphics, 248
scribble, 243
spatter, 258
stained glass, 258
stamp, 257
text, 192
3D, 246–247
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unsharp mask, 253
vector objects, 249

Ellipse tool, 62
ellipses, drawing, 62
embedded graphics, 226–227
endpoints, 149
Enhanced Metafile format, 349
Envelopes, reshaping with, 92
EPS format, 25, 345, 358–359
Eraser tool, 164
erasing path parts, 164
exiting Illustrator, 26
Expand button (Pathfinder panel), 156
Expand command (Objects menu), 125, 134
expanding

gradients, 134
panels, 7
patterns, 125

exporting
documents

as bitmap, 350
Export command, 348
as Flash Movie, 354–355
to Photoshop, 352
with presets, 353
as TIFF format, 351

export file formats, 349
Extension Manager (Adobe), 406, 424
Extensions command (Window menu),

106–107
Eyedropper tool

applying colors and attributes with,
122–123

color attributes, changing, 123
Save For Web & Devices tool, 366

F
families, font, 200
File Handling & Clipboard preferences, 401
File Info command (File menu), 344
file information, inserting into documents,

344–345
file management, Adobe Version Cue, 420
File menu commands

Browse in Bridge, 14–15, 222–223
Close command, 26
Device Center, 39

Document Color Mode, 98, 330
Document Setup, 32, 133
File Info, 344
New, 28–29
New From Template, 30
Open, 12, 220
Open Recent, 13
Open With, 222
Place, 16, 221, 224, 226
Print, 330, 332
Return to Adobe Illustrator, 14
Revert, 24
Save, 24
Save a Copy, 25
Save As, 25, 31
Save For Web & Devices, 364–366
Scripts, 318–319

files
deleting, 12
saving actions as, 309

fills
applying color to, 99, 112, 118
blending fill colors, 126
patterns as, 124–125

Find and Replace command (Edit menu),
326–327

Find Font command, 328
Fit All In Window command (View menu),

44
Fit Artboard In Window command (View

menu), 44
Flare tool, 63
Flash format, SWF, 349, 365
Flash Movie, exporting documents as,

354–355
Flattener Preview command (Window

menu), 39, 341
flattening layers, 182
fonts

bold, 200
condensed, 200
families and styles, 200
Find Font command, 328
finding, 201
italic, 200
replacing, 201
reusing recent, 200
size, 202
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Free Transform tool, 86–87
Fresco effects, 256
full screen mode, 43
FXG format, 25, 360

G
gamut warning icon, 101
Gap options, 272
gaussian blur effects, 252
General preferences, 390
Get Photos from Camera command

(Adobe), 409
GIF documents, optimizing, 372–373
GIF format, 345
glass effects, 257
global colors, 108–110
glowing edges effects, 257
glyphs, 215
Go to Bridge button, 14–15
Gradient tool, 137
gradients

applying to objects, 134
creating, 135
editing, 136
expanding, 134
Gradient tool, 137
linear type, 135
mesh, 92, 138
radial type, 135

grain effects, 258
graphic pen effects, 258
graphics

embedded, 226–227
linked, 226–227
linking, 224–225
opening graphic images, 220
placing, 221–223
print options, 336
raster

interpolation and, 60
tracing, 228–230
understanding raster graphics, 60

styles
applying, 231
breaking links to, 235
creating, 232

deleting, 235
duplicating, 233
editing, 234

graphs, 322
Grayscale color mode, 28, 100
grayscale images, 109
grid colors transparency settings, 33
grid patterns, 19
grid size transparency setting, 32
grids. See also guides

color, 52
displaying in back of artwork, 52
Polar Grid tool, 69
preferences, 52
Rectangle Grid tool, 68
showing and hiding, 52
Snap to Grid command, 52
styles, 52
subdivisions, 52
Transparency, 133

Group command (Objects menu), 76
Group Selection tool, 70
grouping objects, 76–77
groups, creating clipping masks for, 161
guides. See also grids

clearing, 49
color, 48
converting vector objects to, 49
creating, 49
locking, 48
preferences, 48
ruler, 47
showing and hiding, 48
smart guides

object transformation, 87
preferences, 51
turning on/off, 50
working with, 50–51

snap to point, 48
style, 48
switching, 49

H
Hand tool

moving elements around with, 53
quick access to, 53
Save For Web & Devices tool, 366
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handles, 393
hanging indents, 209
hardware, Illustrator CS4 system 

requirements, 3
Help menu commands

Adobe Product Improvement Program,
23

Illustrator Help, 22–23
Updates, 21
Welcome Screen, 13

help options
Community Help site, 22
searching topics, 23

Hide Edges command (View menu), 61
Hide Panels command (Window menu), 18
hiding

anchor points, 61
direction lines, 61
grids, 52
guides, 48
layers, 178
panels, 8, 43
rulers, 47
slices, 380–381
Transparency grid, 133

highlighting anchor points, 142
histograms, 411
History tab (File Info dialog box), 345
HSB color slider (Color panel), 100
HTML text, adding to slices, 386
hue, 101
hyphenation, 211, 397

I
icons, collapsing and expanding panel sets

between icons and panels, 9
Illustrator Help command (Help menu),

22–23
Illustrator tab (File Info dialog box), 345
images

inserting in documents, 16
replacing, 16
working with images using Bridge, 15

importing text, 193
indentation

hanging indents, 209
paragraphs, 209

Info panel

color fill and stroke information, 55
uses for, 55

inner glow effects, 244–245
installing Illustrator CS4

in Macintosh, 3
in Windows, 2

Internet, checking for updates from, 20
interpolation, 60
Inverse command (Select menu), 78
inverting colors, 110
IPTC tab (File Info dialog box), 344
Isolation Mode, 163
italic font, 200

J
joining anchor endpoints, 149
joins, 121
JPEG documents, optimizing, 370–371
JPEG format, 345, 349

K
kerning type, 204
Keyboard Increment general preference,

390
keyboard shortcuts, 403
Knife tool, 152
Knockout Group option, 132
Kuler panel, 106–107

L
landscape/portrait orientation, 35
language settings, document creation, 33
Lasso tool

selecting objects with, 73
understanding selections, 70

layers. See also Layers panel
arranging, 174–175
creating clipping masks for, 161
creating top level layers, 168–169
deleting, 171
deselecting, 170
duplicating, 176
flattening, 182
hiding, 178
locking, 177
merging, 179
moving, 174–175
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moving objects to, 180–181
naming, 169
releasing objects to, 181
selecting, 170
selecting objects with, 172–173
showing and hiding, 178
sublayers, 168–169

Layers panel. See also layers
accessing, 166
components of, 166
locating objects in, 183
options, setting, 167

layouts, workspace, 56
leading text, 203
line graphs, 322
Line Segment tool, 65
line segments, drawing, 65
linear gradient type, 135
linked graphics, 226–227
linking

documents, 16
graphics, 224–225
slices, 381

Liquify tools, 289
Live Color feature

applying color groups to objects with,
114–115

editing colors with, 114–115
Live Paint Bucket tool

paint fills, 266
preferences, setting, 265
selecting options to paint fills or strokes

with, 264
stroke edges, changing, 267

Live Paint Groups
adding paths to, 271
converting traced objects to, 263
creating, 262–263
Gap options, 272
reshaping or moving paths in, 270–271

Live Paint Selection tool, 268–269
locking
guides, 48
layers, 177

lossy compression, 373
lowercase text, 329
luminosity, 101

M
Macintosh

Illustrator CS4 system requirements, 3
installing Illustrator CS4 in, 3
starting Illustrator CS4 in, 5

Macintosh PICT format, 349
Magic Wand tool

selecting objects with, 74–75
understanding selections, 70

marks print options, 334–335
Measure tool, 55
measurement

distance between objects, measuring, 55
measurement units, document creation,

32
menus, 6
merging

layers, 179
paths, 154–155

mesh, 92, 138 
metadata, 345
Microsoft Office, saving documents as, 361
miter bend style, 83
miter joins, 121
Mobile SWF tab (File Info dialog box), 344
mosaic tiles effects, 258
Move tool, 50
moving

anchor points, 142–143
artboards, 36
document elements with Hand tool, 53
layers, 174–175
objects, 81
objects to layers, 180–181
segments, 142–143
slices, 382
text, 191, 196–197
between tools, 53

N
naming

layers, 169
selections, 80
workspaces, 56

navigation
artboards, 37
within artboards, 34
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Navigator panel
customizing, 42
view area, 41
view box color, 42
view size, 40

New command (File menu), 28–29
New From Template command (File menu),

30
New View command (View menu), 38
Next Object Above command (Select

menu), 78
Next Object Below command (Select

menu), 78
nonglobal colors, 108–110
normal screen mode, 43
note paper effects, 257

O
objects

alignment, 84
applying color to, 99, 112, 118
clearing, 81
deleting, 81
distributing, 84
duplicating, 82–83
grouping, 76–77
measuring distance between, 55
moving, 81
moving to layers, 180–181
reflecting, 85, 89
rotating, 85–86, 88
scaling, 85, 88
selecting

with Lasso tool, 73
with Magic Wand tool, 74–75
similar objects, 78–79
using Direction Selection tool, 72
using Select menu, 78–79
using Selection tool, 71

transforming, 85–87
Objects menu commands

Blend, 127–128
Clipping Mask, 160
Compound Path, 158
Expand, 125, 134
Group, 76
Text Wrap, 216

Transform, 90
Ungroup, 76

offsetting paths, 83
opacity, blends, 131
Open command (File menu), 12, 220
open paths, 61, 147
Open Recent command (File menu), 13
Open With command (File menu), 222
opening

documents
with Adobe Bridge, 14–15
existing documents, 12
recently opened, 13
from Welcome Screen, 13

graphic images, 220
panels, 7

Origin tab (File Info dialog box), 345
outer flow effects, 244–245
Outline view, 38–39
outlines, 217
output print options, 338–339
output slice settings, 385
overflow, text, 198–199
Overprint Preview command (View menu),

39, 337

P
Paintbrush tool, 151
painting

art brushes, 280–281
Brushes panel, 273
calligraphic brushes, 278–279
Live Paint Bucket tool, 264–267
Live Paint Groups

adding paths to, 271
converting traced objects to, 263
creating, 262–263
Gap options, 272
reshaping or moving paths in,

270–271
Live Paint Selection tool, 268–269
Paintbrush tool, 274–275

pattern brushes, 282–283
scatter brushes, 276–277

panel knife effects, 256
Panel Options menu, 7, 9
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panels
adding, 8
closing, 7
collapsing, 7
displaying hidden, 43
docking/undocking, 8
expanding, 7
hiding, 8, 43
opening, 7
Panel Options menu, 9
sets, collapsing and expanding between

icons and panels, 9
subtracting, 8

paragraphs
alignment, 208
indentation, 209
spacing, 209

Paste command (Edit menu), 196–197
Paste in Back command (Edit menu), 197
Paste in Front command (Edit menu), 197
Pathfinder panel, 156
paths

anchor points and, 61
clipping mask, 160–163
closed, 61
compound, 158–159
dividing, 153
erasing parts of, 164, 260
merging, 154–155
offsetting, 83
open, 61, 147
reshaping, 150–151
segments and, 61
Shape Mode command, 156
shape of, changing, 61
splitting, 152–153

pattern brushes, 282–283
patterns

applying to objects, 124
editing, 125
expanding, 125
as fills, 124–125

PDF format, 25, 345, 356–357
Pen tool

anchor points, adding, 147
drawing curves with, 141
drawing polygons with, 140

Pencil tool
preferences, 261
reshaping paths with, 151
working with, 260–261

Photoshop Effect Gallery, 250–251
Photoshop, exporting to, 352
Photoshop format, 349
pie graphs, 322
Pixel Preview command (View menu), 39
pixels, 35
Place command (File menu), 16, 221, 224,

226
placing graphics, 221–223
plastic wrap effects, 258
Play button (Actions panel), 309
playback, action, 311
plug-in preferences, 398
PNG format, 345, 349
PNG-8 document, 374–375
PNG-24 document, 376
point type, 187
point/pica size, 46
points, anchor

adding new, 146–147
alignment, 148–149
Convert Anchor Point tool, 145
converting, 144–145
deleting, 147
direction lines, 142
endpoints, 149
highlighting, 142
moving, 142–143
paths and, 61
preferences, 142
selecting with Direct Selection tool, 72
showing and hiding, 61
smooth points, converting to corner

points, 144
Polar Grid tool, 69
Polygon tool, 64
polygons, drawing, 64, 140
portrait/landscape orientation, 35
preferences

Adobe Bridge, 414–415
anchor points, 142
Appearance of Black, 402
cursor, 390
File Handling & Clipboard, 401
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General, 390
grids, 52
guide, 48
hyphenation, 397
keyboard shortcut, 403
Live Paint Bucket tool, 265
Pencil tool, 261
plug-in, 398
ruler, 46
Scratch Disk, 399
Selection & Anchor Display, 392–393
slices, 397
smart guides, 51
text, 394–395
Transparency grid, 133
type, 394–395
Units & Display Performance, 396
updates, 20
user interface, 400

presets
artboard, 34
creating new documents using, 29
exporting with, 353
list of, 29
printing with, 331, 340

Preview view, 38–39
Preview View command (View menu), 260
previewing

artboards, 36
color separations, 337
effects, 240

Print command (File menu), 330, 332
Print Presets command (Edit menu), 331
printing

advanced print options, 340–341
bleed options, 335
color management settings, 342
color separations, previewing, 337
documents, 330
general print options, 332–333
graphics print options, 336
marks options, 334–335
number of copies, specifying, 333
output options, setting, 338–339
Overprint preview, 337
overprints, 340
presets, 340

with presets, 331
Print command, 330
print problems, checking for, 343
print tiling, 333
reverse order, 332
Separations preview, 337
summary print options, 343

Product Improvement Program (Adobe), 23
Proof Colors command (View menu), 116
Proof Setup command (View menu), 39
proofing colors, 116
PSD format, 345
Pucker tool, 286
punctuation, 214

Q
Quit Illustrator command (Illustrator menu),

26
quotes, 33

R
radar graphs, 322
radial gradient type, 135
raster graphics

effects, 248
interpolation and, 60
tracing, 228–230
understanding raster graphics, 60

Raw Data tab (File Info dialog box), 345
Record button (Actions panel), 309
recording actions, 310
Rectangle Grid tool, 68
Rectangle tool, 63
rectangles, drawing, 63
Redo command (Edit menu), 58
Reflect tool, 89
reflecting objects, 85, 89
registration, 4–5
releasing

compound paths, 159
objects from clipping masks, 161
objects to layers, 181

renaming
data sets, 321
selections, 80
workspaces, 57
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rendering intent color management print
option, 342

replacing
colors, 108–109
fonts, 201
images, 16

Reselect command (Select menu), 78
Reshape tool, 150
reshaping paths, 150–151
resizing

artboards, 36
slices, 382

resolution preset transparency setting, 33
Return to Adobe Illustrator command (File

menu), 14
reverse order printing, 332
Revert command (File menu), 24
revolving 3D effects, 247
RGB (Red, Green, Blue) color mode, 28, 97,

100
Rotate tool, 88
rotating

artboards, 36
objects, 85–86, 88
text, 207

round bend style, 83
round joins, 121
Rounded Rectangle tool, 63
RTF format, 193
rulers

artboard display options, 37, 47
displaying, 46–47
document, 46–47
guides

alignment, 51
changing, 47
clearing, 49
color, 48
converting vector objects to, 49
creating, 49
locking, 48
preferences, 48
ruler, 47
showing and hiding, 48
smart guides, 50–51
snap to point, 48
style, 48
switching, 49

hiding, 47
origin, changing, 47
preferences, 46

S
safe area, artboard display options, 37
Same command (Select menu), 79
saturation, color, 101
Save a Copy command (File menu), 25
Save As command (File menu), 25, 31
Save command (File menu), 24
Save For Web & Devices command (File

menu), 364–366
Save Selection command (Select menu), 80
Save Workspace command (Workspace

menu), 56
saving

actions
as files, 309
into sets, 309

documents, 24–25
as Adobe Flex File, 360
as EPS format, 358–359
as FXG format, 360
as Microsoft Office, 361
as PDF format, 356–357
as template, 362
for the Web, 364–365

selections, 80
slices for Web, 384–385
symbols, 291

Scale tool, 88
scaling

objects, 85, 88
type, 206

Scallop tool, 286
scatter brushes, 276–277
scatter graphs, 322
Scissor tool, 152
Scratch Disk preferences, 399
screen modes, 43
scribble effects, 243
scripts, actions, 318–319
searching

fonts, 201
for help information, 23

segments
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curve, 143
moving, 142–143
paths and, 61
selecting with Direct Selection tool, 72

Select menu commands, 78–79
Edit Selection, 80
Same command, 79
Save Selection, 80

Selection & Anchor Display preferences,
392–393

Selection tool. See also selections
aligning and distributing objects using,

84
duplicating objects with, 82–83
moving objects with, 81
reflecting or shearing objects, 89
rotating and scale objects with, 88
selecting objects with, 71
transforming objects with, 85
understanding selections, 70

selections. See also Selection tool
anchor points, 72
controlling effects using, 255
deleting, 80
editing, 80
examples of, 70
inverting color of, 78
layers, 170
naming, 80
renaming, 80
reselecting, 78
saving, 80
selecting next object above/below cur-

rent, 78
slices, 380–381
type, 194–195
understanding selections, 70

sentence case, 329
Separations Preview command (Window

menu), 39
Shape Mode command (Pathfinder panel),

156
Share My Screen command, 419
Sharpen command (Effect menu), 253
Shear tool, 89
shortcuts

starting Illustrator CS4, 4–5
tool, 11

Show Bounding Box command (View
menu), 85

Show Edges command (View menu), 61
Show Panels command (Window menu), 18
Show Print Tiling command (View menu),

38
Show Text Threads command (View menu),

198
Show Transparency Grid command (View

menu), 133
single quotes, 33
size

artboard, 35
font, 202
views, 40

Slice Selection tool, 366
slices

alignment, 383
arranging, 382–383
auto, 378
deleting, 380
distributing, 383
duplicating, 380
hiding, 380–381
HTML text, adding, 386
linking, 381
moving, 382
output option settings, 385
preferences, 397
resizing, 382
saving for Web, 384–385
selecting, 380–381
showing, 380–381
stacking, 383
subslices, 379
unlinking, 381
URL links, adding, 387
user, 378
viewing slice options, 380–381
working with, 381

smart guides
object transformation, 87
preferences, 51
turning on/off, 50
working with, 50–51

Smart Punctuation, 214
smooth points, converting to corner points,

144
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Snap to Grid command, 52
Snap to Point command, 48, 392
soft proof colors, 116
software, Illustrator CS4 system require-

ments, 3
spacing paragraphs, 209
spatter effects, 258
spell checking, 324–325
Spiral tool, 66–67
spirals, drawing, 66–67
splitting paths, 152–153
stacked bar graphs, 322
stacked column graphs, 322
stacking slices, 383
stained glass effects, 258
stamp effects, 257
Star tool, 64
stars, drawing, 64
Start menu, opening documents using, 13
starting Illustrator CS4

in Macintosh, 5
shortcuts, 4–5
Welcome screen, 4
in Windows, 4

status bar, 17
Stop button (Actions panel), 309
stops, adding to actions, 312
stroke

alignment, 120
applying color to, 99, 112, 118
attributes, changing, 120–121
caps or joins, changing, 121
dashed, 121
weight of, changing, 120

styles
font, 200
graphic

applying, 231
breaking links to, 235
creating, 232
deleting, 235
duplicating, 233
editing, 234

grids, 52
guides, 48
type, 212–213

Stylize command (Effect menu), 243

sublayers, 168–169
subscript text, 33
subslices, 379
subtracting panels, 8
summary print options, 343
superscript text, 33
SVG format, 25, 365
Swatches Library

copying swatches between libraries, 104
customized swatch panels, saving, 105
displaying, 104
gradient library, 134

Swatches panel
creating color groups in, 103
deleting colors from, 102
display of, changing, 102
editing or duplicating color in, 103
sorting colors in, 102
swatches, displaying by type, 102
Swatches Library, 104–105

SWF format, Flash, 349, 365
symbols

creating, 290
deleting, 291
duplicating, 292
editing, 293
links, breaking, 294–295
saving, 291
sets, expanding instances of, 305
Symbol Libraries, 289
Symbol Screener tool, 303
Symbol Scruncher tool, 299
Symbol Shifter tool, 298
Symbol Sizer tool, 300
Symbol Spinner tool, 301
Symbol Sprayer tool, 296
Symbol Strainer tool, 302
Symbol Styler tool, 304
symbolism tool options, setting, 297
Symbols panel, 288

system requirements, 3

T
tab stops, 210
tabbed documents, 18
tabs, 210
Targa format, 349
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templates
creating documents from, 30–31
document, 16, 30–31
saving documents as, 362

text
case, 329
copying, 196–197
effects, 192
fonts, 200–202
glyphs, 215
hyphenation, 211
importing, 193
kerning, 204
leading, 203
moving, 191, 196–197
outlines, 217
overflow, 198–199
paragraphs, 208–209
preferences, 394–395
rotating, 207
scaling, 206
selecting, 194–195
styles, 212–213
subscript, 33
superscript, 33
tabs, 210
threads, 198–199
tracking, 205
typing new, 187–188
wrapping, 216

Text Format, 349
Text Wrap command (Objects menu), 216
themes, color, 106–107
threads, text, 198–199
3D effects, 246–247
thumbnail views, 41
TIFF format, 345, 349, 351
Tolerance selection option, 392
tool tips, 391
tools

accessing in Tools panel, 10
accessing multiple, 10
Control panel, 6
moving between, 53
shortcuts to, 11

Tools panel
accessing tools in, 10

contents of, 6
tracing raster graphics, 228–230
tracking type, 205
transformations

applying multiple, 90–91
blends, 130
Distort & Transform command, 90
repeating, 90
Transform Each command, 90

transforming objects, 85–87
Transparency Flattener Presets command

(Edit menu), 341
Transparency grid, 133
transparency settings

blends, 132
colored paper simulation, 33
controlling transparency effects, 132
document creation, 32–33
grid colors, 33
grid size, 32
resolution preset, 33

turning on/off smart guides, 50
TXT format, 193
type

Area Type tool, 189
copying, 196–197
fonts, 200–202
kerning, 204
leading, 203
moving, 196–197
outlines, 217
overflow, 198–199
paragraphs, 208–209
preferences, 394–395
rotating, 207
scaling, 206
selecting, 194–195
styles, 212–213
threads, 198–199
tracking value, 205
Type on a Path tool, 190
Vertical Area Type tool, 189
Vertical Type on a Path tool, 190
Vertical Type tool, 187
wrapping, 216

Type on a Path tool, 190
Type tool, 186
typographer's quotes, 33
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Twirl tool, 286

U
Undo command (Edit menu), 58
undocking

documents, 19
panels, 8

Ungroup command (Objects menu), 76
Units & Display Performance preferences,

396
unsharp mask effects, 253
Updater (Adobe), 21
updates

checking for, 20–21
preferences, 20

Updates command (Help menu), 21
updating, from previous versions, 2
uppercase text, 329
URL links, adding to slices, 387
user interface preferences, 400
user slices, 378

V
variables, data

creating, 320–321
deleting, 320–321
renaming, 321

vector objects
converting to guide, 49
effects, 249
understanding vector graphics, 60

Version Cue (Adobe)
basic description of, 406
file management, 420

Vertical Area Type tool, 189
Vertical Type on a Path tool, 190
Vertical Type tool, 187
Video Data tab (File Info dialog box), 344
video safe areas, artboards, 35
View menu commands

Bounding Box, 270–271
Edit View, 38
Fit All In Window, 44
Fit Artboard In Window, 44
Hide Edges, 61
New View, 38
Overprint Preview, 39

Pixel Preview, 39
Preview View, 260
Proof Colors, 116
Proof Setup, 39
Rulers, 46
Show Bounding Box, 85
Show Edges, 61
Show Print Tiling, 38
Show Text Threads, 198
Show Transparency Grid, 133
Smart Guides, 50
Soft Proof, 116

view size, documents, 17
views

box color, 42
changing, with Zoom tool, 44–45
display view, changing, 38–39
document, 38–41
fit in window, 44
Outline, 38–39
Preview, 38–39
ruler options, 46
size, 40
thumbnail, 41

W
Warp tool, 286
WBMP document, optimizing, 377
Web

file formats, 368–369
GIF documents, optimizing, 372–373
images, optimizing to file size, 367
JPEG documents, optimizing, 370–371
PNG-8 document, optimizing, 374–375
PNG-24 document, optimizing, 376
saving documents for, 364–365
saving slices for, 384–385
WBMP document, optimizing, 377

Web-safe color, 101
Welcome screen, 4, 13
Welcome Screen command (Help menu), 13
Window menu

Extensions, 106–107
Flattener Preview, 39
panel display, 7–8

Window menu commands
Flattener Preview, 341
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Hide Panels, 18
Separations preview, 39
Show Panels, 18

Windows
Illustrator CS4 system requirements, 3
installing Illustrator CS4 in, 2
starting Illustrator CS4 in, 4

windows
active, 18
document, 18–19

Windows Metafile format, 349
Workspace menu commands, 56
workspaces

creating, 56
deleting, 57
displaying, 56
layouts, 56
naming, 56
renaming, 57

wrapping text, 216
Wrinkle tool, 286

X
X and Y positioning, 35
XMP format, 344
XMP Software Development Kit, 345

Z
zoom

in/out, 45
using Navigator thumbnail, 41
view size, 40

Zoom tool
changing view with, 44–45
Save For Web & Devices tool, 366

Z00ILCS4.qxp  11/5/2008  1:44 AM  Page 459



Z00ILCS4.qxp  11/5/2008  1:44 AM  Page 460


	Introduction
	Chapter 3: Working with Objects
	Index



